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1 Introduction 

1.1 About This Guide 
This guide provides step-by-step procedures and reference information for BroadWorks 
Call Center Release 14.sp6. 

BroadWorks Call Center herein is referred to as Call Center. 

1.2 Overview  
BroadWorks Call Center is a carrier-class, lightweight desktop communications 
management product for everyday users of Microsoft Outlook or Internet Explorer with the 
BroadSoft® BroadWorks® telephony softswitch platform. 

With BroadWorks Call Center you can manage Call Center activity from your desktop. 

BroadWorks Call Center delivers the following real benefits to users: 

 An elegant design that is aesthetically pleasing 

 An ergonomic design that follows the natural “workflow” of a call from the top to the 
bottom of the screen 

 Improved business processes as only “valid” options are presented to the attendant 

 Professional call handling as critical information is available in “real time” 

Along with this focus on design, BroadWorks Call Center employs the latest technology 
platforms and communications facilities. 

1.3 Audience 
This document is intended for end users of Call Center. 

1.4 Additional Resources  
For Application Server procedures used by group administrators, department 
administrators, and users, see the following BroadWorks guides: 

 BroadWorks Application Server Group Web Interface Administration Guide  
(Parts 1 and 2) 

 BroadWorks Getting Started Web Interface Administration Guide 

 BroadWorks Application Server User Web Interface Administration Guide 

 BroadWorks CommPilot Call Manager User Guide 



 
 

1.5 First Time Login for Agents  
When starting Call Center for the first time, several items must be correctly configured or 
checked. 

To start Call Center on subsequent occasions, follow the procedure in section 1.7 
Subsequent Use. 

To start Call Center: 

Navigate to the program group BroadSoft, followed by BroadWorks Call Center. 

1) Click the BroadWorks Call Center shortcut. 

 

Figure 1  Start Menu 

Call Center starts and you are presented with the following login interface: 

 

Figure 2  Login Interface 

Enter your service provider username and password.  If you are unsure of your 
username and password, contact your service provider. 

You can also select the Remember Me (or Forget me) and the Save Password option 
so that your username and password are remembered on your machine. 
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Check Sign me in automatically to log in to BroadWorks Call Center if a forced logout 
occurs. 

3) From the Tools menu, select Options.  The BroadWorks Call Center - Options dialog 
box opens on the General screen.  Check Show call notifications to show notifications 
and In auto answer mode if you want visible notifications when answering calls 
automatically.  Check Show call notifications to show notifications.  Check In auto 
answer mode if you want visible call notifications when auto answer is enabled.   

The Language drop-down list allows the option of changing the language from the 
default English (US).  The language options are: 

− English (US) 

− French (France) 

− German (Germany) 

− Italian (Italy) 

− Spanish (Spain) 

− Spanish (CALA), for Central and Latin America 

− Simplified Chinese (PRC), for People’s Republic of China 

− Any custom language the administrator has specified 

Selecting the desired language, click OK and restart Receptionist for the changes to 
take place. 

Sync to service provider language, when checked, enables Call Center to 
automatically match the application language to the language set within the 
BroadWorks subscribers’ profile after signing-in.   

NOTE:  If no profile match is found, the language will remain set to the current language. 



 
 

 

Figure 3  Options Dialog – General Screen 

2) Click on the Connection tab and enter the server’s host name (Host Address) and port 
number (Host Port) for your service provider.  To obtain this information, contact your 
service provider. 

 

Figure 4  Options Dialog – Connection Screen 
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3) Click on the Agent tab.  Check Join to participate in the Automatic Call Distribution 
(ACD) for your Call Center.  To configure the Agent Settings: 

The preferred post sign-in ACD state options are: 

− Available sets your ACD state as available to take calls when you log in. 

− Unavailable sets your ACD state as unavailable to take calls when you log in. 

The post-call ACD state options are: 

− Wrap-up configures your status as Wrap-up on completion of a call.  When using 
Wrap-up, check the Timed wrap-up period and select the length of time before 
your status changes to Available upon the completion of a call. 

− Available displays your status as Available upon the completion of a call. 

− Unavailable displays your status as Unavailable upon the completion of a call. 

Agent timed Wrap-Up allows the agent to set a single timer for each Call Center in 
minutes and seconds.  Agent timed Wrap-Up is overridden if the Enable maximum 
ACD Wrap-up timer on the Call Center Profile page is checked.  This profile option is 
set on a per Call Center basis. 

The Archive Frequency can be set to “Daily”, “Weekly”, “Monthly”, or “Do Not Archive”.  
The default is set to “Weekly”. 

 

Figure 5  Options Dialog – Call Center – Agent Screen 

4) Click on the Updates tab and enter the proxy connection settings for your network, if it 
has a proxy server. 
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Figure 6  Options Dialog – Updates Screen 

− Enter the Type of proxy from the drop-down list. 

− Enter the Server information. 

− Enter the Port. 

− Enter the User ID and then the Password. 

5) Click OK. 

6) Click LOG IN from the login screen. 
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1.6 First Time Login for Supervisors  
When starting Call Center for the first time, several items must be correctly configured or 
checked. 

To start Call Center on subsequent occasions, follow the procedure in section 1.7 
Subsequent Use. 

To start Call Center: 

1) Navigate to the program group BroadSoft, followed by BroadWorks Call Center. 

2) Click the BroadWorks Call Center shortcut. 

 

Figure 7  Start Menu 

Call Center starts and you are presented with the following login interface: 

 

Figure 8  Login Interface 

Enter your service provider username and password.  If you are unsure of your 
username and password, contact your service provider. 

You can also select the Remember Me (or Forget me) and the Save Password option 
so that your username and password are remembered on your machine. 

Check Sign me in automatically to log in to BroadWorks Call Center if a forced logout 
occurs. 
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4) From the Tools menu, select Options.  The BroadWorks Call Center - Options dialog 
box opens on the General screen.  Check Show call notifications to show notifications.  
Check In auto answer mode if you want visible call notifications when auto answer is 
enabled.   

The Language drop-down list allows the option of changing the language from the 
default English (US).  The language options are: 

− English (US) 

− French (France) 

− German (Germany) 

− Italian (Italy) 

− Spanish (Spain) 

− Spanish (CALA), for Central and Latin America 

− Simplified Chinese (PRC), for People’s Republic of China 

− Any custom language the administrator has specified 

Selecting the desired language, click OK and restart Receptionist for the changes to 
take place. 

Synchronize language with service profile, when checked, enables Call Center to 
automatically match the application language to the language set within the 
BroadWorks subscribers’ profile after signing-in.   

NOTE:  If no profile match is found, the language will remain set to the current language. 

 



 
 

 

Figure 9  Options Dialog – General Screen 
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4) Click on the Connection tab and enter the server’s host name (Host Address) and port 
number (Host Port) for your service provider.  To obtain this information, contact your 
service provider. 

 

Figure 10  Options Dialog – Connection Screen 
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5) Click on the Agent tab.  Check Manage to control the ACD for your Call Center.  To 
configure the Agent Settings do the following. 

The preferred sign-in state options are: 

− Available sets your ACD state as available to take calls when you log in. 

− Unavailable sets your ACD state as unavailable to take calls when you log in. 

The post-call state options are: 

− Wrap-up configures your status as Wrap-up on completion of a call.  When using 
Wrap-up, check the Time wrap-up period and select the length of time before 
your status changes to Available upon the completion of a call. 

− Available displays your status as Available upon the completion of a call. 

− Unavailable displays your status as Unavailable upon the completion of a call. 

 

Figure 11  Options Dialog – Call Center – Agent Screen 
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6) Click on the Update tab and enter the proxy connection settings for your network, if it 
has a proxy server. 

 

Figure 12  Options Dialog – Updates Screen 

− Enter the Type of proxy from the drop-down list. 

− Enter the Server information. 

− Enter the Port. 

− Enter the User ID and then the Password. 

7) Click OK. 

8) Click LOG IN from the login screen. 

9) From the Tools menu select the Options tab. 
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10) Click the Supervisor tab.  Enter the Call Center password and check Save password.  
This remembers the password for the Call Center you are supervising.  This 
information is available from your service provider.  To use a warning tone when 
barging in, click Yes.  The default option is “No”. 

 

Figure 13  Options Dialog – Call Center – Supervisor Screen 

11) To save your changes click OK. 
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1.7 Subsequent Use  
1) Navigate to the program group BroadSoft, followed by BroadWorks Call Center. 

2) Click the BroadWorks Call Center shortcut. 

 

Figure 14  Start Menu 

3) Click LOG IN. 

 

Figure 15  Login Interface 
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2 Using Call Center 

2.1 Main Interface  
Figure 16 shows the main interface: 

 

Figure 16  Main Interface 

The following legend provides the names to the sections of the main interface.  This is 
followed by more detailed information. 

Legend: 
1. Menu panel 

2. Call Center panel 

3. Content panel 
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Detailed Description 
1. Menu panel:  This is located at the top right-hand panel of the main interface and 

provides a list of options to configure Call Center. 

 

Figure 17  Menu Panel 

 The File menu contains the following menu items: 

− Sign out signs you out of Call Center. 

− Exit logs you out of Call Center and displays the Login screen. 

 The View menu contains the following menu items: 

− The Directories list brings up the Contact Directory, Personal Directory, 
Speed Dials Directory, LDAP Directory, and Outlook Directory.  To display 
the directories, check the corresponding boxes.  If you want them hidden, 
uncheck the directories you want to hide. 

− The Reports list launches the Agent Activity Report, Agent Utilization Report, 
Queue Performance Report, and Service Level Report.  These reports are 
only available to supervisors, with the exception of the Agent Activity Reports, 
which are used by agents to view their own statistics only. 

− Monitoring makes the teams and Call Centers you are able to see visible.  If 
you want these visible, check the box.  If you do not want them visible, leave 
the box unchecked. 

− Dashboard is a summary of statistics on a per Call Center basis.  Each AVD 
or queue is monitored as well as agents.  This is only available to 
supervisors.  To make the Dashboard visible, check the corresponding box. 

− Always on top, when checked, ensures that Call Center is higher than any 
other open application. 

 The Tools menu contains Call History and Options in the drop-down list. 

− The Call History dialog box displays information about the history of calls in 
the queue.  It is split up into three sections:  Dialed Calls, Received Calls, and 
Missed Calls.  The following list describes the columns on the Call History 
tab: 

− Name displays the name of the caller. 

− Number is the number of the caller. 

− Time displays the date of the call in hours, minutes, the day, the month, 
and then the year. 

− The Options dialog allows you to configure your Call Center.  For detailed 
descriptions of the tabs, see section 2.2 Tools Dialog. 

2. Call Center panel:  This is located on the second panel of the main interface. 
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Figure 18  Call Center Panel 

It has the following components (from left to right): 

 The Available button, when clicked, changes your availability status to Available 
to receive calls. 

 The Unavailable button, when clicked, changes your availability status to 
Unavailable to receive calls. 

 The Wrap-Up button, when clicked, changes your status to Wrap-up.  Time 
allocated to the wrap up is captured in agent statistics. 

 The Answer button, when clicked, picks up the active incoming call.  If your 
device is Advanced Call Control-compliant, your Answer button doubles as your 
Hold button according to the context of your call. 

 The Transfer button, when clicked, transfers the active call.  There are three types 
of call transfers available.  For more information, see section 2.12.2 Blind Transfer 
Call, section 2.12.3 Transfer Call with Consultation, and section 2.11 Manage 
Queues. 

 The Conference button, when clicked, initiates a conference call. 

 The End button, when clicked, disconnects the active call. 

 The Escalate button, when clicked, makes a new call to the selected supervisor 
and puts the active call on hold. 

 The Barge-In button is only for supervisors.  When clicked, it allows you to barge 
in on the active call. 

 The Call Pick-Up button is only for supervisors.  When checked, it allows you to 
pick up an unanswered call. 

NOTE:  You must be assigned the BroadWorks Directed Call Pick-Up with Barge-In feature to 
use the Barge-In button.  Contact your administrator to activate this service. 

3. Content panel:  This is located on the third panel of the main interface. 

It has the following components (from left to right): 

 The Contact Directory tab displays a list of all users in your BroadWorks 
enterprise or group. 

 

Figure 19  Contact Directory Tab 

The following list describes the columns on the Contact Directory tab: 

− Name displays the name appearing in your BroadWorks Group Directory. 

− Extension is the number appearing in your Group Directory. 
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− Department is the department appearing in your Group Directory. 

− Phone is the telephone number appearing in your Group Directory. 

− Mobile is the mobile number appearing in your Group Directory. 

 The LDAP Directory tab displays information from your Lightweight Directory 
Access Protocol (LDAP) Directory.  If the group you belong to has not been 
assigned the LDAP Integration service, or the service is assigned but is turned off, 
the tab does not display any entries. 

 

Figure 20  LDAP Directory Tab 

The following list describes the columns on the LDAP Directory tab: 

− Name is the name appearing in your LDAP Directory. 

− Title is the title appearing in your LDAP Directory. 

− Phone is the telephone number appearing in your LDAP Directory. 

 The Personal Directory tab displays information from your Personal Directory in 
CommPilot Web Portal. 

 

Figure 21  Personal Directory Tab 

The following list describes the columns on the Personal Directory tab: 

− Name is the name appearing in your CommPilot Web Portal Personal 
Directory. 

− Phone is the telephone number appearing in your CommPilot Web Portal 
Personal Directory. 

 The Speed Dials tab displays information from your Speed Dial Directory in Call 
Center. 

 

Figure 22  Speed Dial Tab 

− Speed Code is the code associated with the speed dial. 

− Phone is the telephone number associated with the speed code. 

− Description is the description of the speed dial. 

 The Dashboard tab displays a bar chart of all Call Center queue status along with 
a per-queue summary table.  This is only available to supervisors.  The 
Dashboard presents the health of each automatic call distribution (ACD) or queue 
they are managing as well as their agents.  You can toggle through the data and 
resize it using a horizontal splitter bar. 
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Figure 23  Dashboard Tab 

 The Monitoring tab displays a real-time view of the teams and Call Centers 
assigned to you.  This is only available to supervisors.  The Call Centers can be 
expanded by clicking on the left-hand plus icon corresponding to each Call 
Center. 

 

Figure 24  Monitoring Tab 

 

 The Agent Activity Report displays information about the grade of service or the 
measure of how long it took for the call offered to be answered.  This can be set 
for all agents.  If an agent has made the report, it only contains their information.  
For more information, see section 2.8.3 Agent Activity Report. 
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Figure 25  Agent Activity Report 

 The Agent Utilization Report displays information about the agents’ call handling 
activity.  This can be set to “All Agents”.  For more information, see section  
2.8.4 Agent Utilization Report. 

 

Figure 26  Agent Utilization Report 

 The Queue Performance Analysis Report displays information about the 
performance of the queue.  Real-time reports are shown in a viewer and 
refreshed at regular intervals.  For more information, see section 2.8.5 Queue 
Performance Analysis Report. 
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Figure 27  Queue Performance Report 

 

 The Service Level Report displays information about the grade of service or the 
measure of how long it took for the calls offered to be answered.  Real-time 
reports are shown in a viewer and refreshed at regular intervals.  For more 
information, see section 2.8.6 Service Level Report. 

 

Figure 28  Service Level Report 
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2.2 Tools Dialog  
The Tools dialog box is used to configure user/service provider settings and preferences.  
The dialog box can be displayed from the Tools menu by selecting Tools – Options.  It is 
available on both the login and main interface screens.  The dialog box displays the tabs 
shown in the following sub-sections: 

2.2.1 General Tab  

The General tab contains miscellaneous features that improve the usability of Call Center. 

 

Figure 29  Options Dialog – General Screen 

The General Option is as follows: 

 Auto login when connected to network connects you to Call Center as soon as the 
network is detected. 

 Show call notifications ensures notifications are visible when there is an incoming call. 

 In auto answer mode, when checked, ensures that notifications are visible when there 
is an incoming call, despite it being automatically answered. 

The Language options are as follows: 

 The Language drop-down list allows the option of changing the language from the 
default English (US).  The language options are: 

− English (US) 

− French (France) 
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− German (Germany) 

− Italian (Italy) 

− Spanish (Spain) 

− Spanish (CALA), for Central and Latin America 

− Simplified Chinese (PRC), for People’s Republic of China 

− Any custom language the administrator has specified 

Selecting the desired language, click OK and restart Call Center for the changes to 
take place. 

 Synchronize language with service provider, when checked, enables Call Center to 
automatically match the application language to the language set within the 
subscribers’ BroadWorks profile after signing-in. 

NOTE:  If no profile match is found, the language will remain set to the current language. 



 
 

2.2.2 Connection Tab  

Click on the Connection tab to configure the connection information required to connect to 
your service provider. 

 

Figure 30  Options Dialog – Connections Screen 

The Server Connection Information is as follows: 

 The Host Address (Server URL) is the host name/IP address for service.  This is 
compulsory and can be obtained from the service provider. 

 The Host Port (Server Port) is the port number for service.  This is compulsory and 
can be obtained from the service provider. 
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2.2.3 Call Center – Agent Tab  

Click on the Call Center – Agent tab to see your settings as a Call Center agent. 

 

Figure 31  Options Dialog – Agent Screen 

The Call Center Management options are as follows: 

 Call Center is required.  Contact the group administrator if your Call Centers do not 
appear. 

 The ACD State displays your availability.  The login states are as follows:  Green is 
logged in.  Red means your last login failed.  Grey indicates you are not logged in. 

 ACD Wrap-Up defines the time allowed for a wrap-up in that Call Center. 

 Join, when checked, ensures that you are a member of Call Center. 

The Agent ACD Policy options are as follows: 

 The Agent post sign-in ACD state is compulsory.  Select the login state from the drop-
down list.  The two possible states are Available and Unavailable. 

 The Agent post call ACD state is required.  Select the post call state from the drop-
down list.  The three possible states are Wrap-up, Available, and Unavailable. 

 Agent timed Wrap-Up should be checked if you want to indicate that a wrap-up state 
is bound in time.  Select the time allotted to the wrap-up state from the drop-down list 
in minutes and seconds (mm:ss). 

BROADWORKS CALL CENTER AGENT/SUPERVISOR USER GUIDE 40-CA5904-00 
©2008 BROADSOFT, INC. PAGE 34 OF 97 



 
 

BROADWORKS CALL CENTER AGENT/SUPERVISOR USER GUIDE 40-CA5904-00 
©2008 BROADSOFT, INC. PAGE 35 OF 97 

The Activity Archive option is as follows: 

 Archive Frequency allows you to allocate how frequently the Agent/Supervisor client 
call and ACD event records are archived.  The options from the drop-down list are Do 
Not Archive, Daily, Weekly, and Monthly. 

The archive is saved at the desired interval as a comma separated value (CSV) file in 
the following path: 

<Drive>:\Documents and Settings\<Windows_Username>\Application 
Data\BroadSoft\BW Call Center\profiles\<BW_UserID>\statistics where: 

− Drive is the drive letter where your profile is stored (typically C) 

− Windows_Username is your Windows user name 

− BW_User_ID is your BroadWorks user ID 

The following events are captured based on activity that occurs on the Agent/Supervisor 
client (irrespective of ACD or direct inbound or outbound calls): 

Statistic Description Allowed Values Example Value 

BW User ID BroadWorks user ID String jsmith@abc.net 

Call Center ID Call Center ID for inbound 
ACD calls only 

String, null ABCSales 

Availability Agent’s joined state Joined, Not Joined, null Joined 

ACD State Agent’s ACD state Sign-On, Available, 
Unavailable, Wrap-Up, 
Sign-Out, null 

null 

Call ID ID of the call String, null 192.168.1.5:1 

Call State State of the call Idle, Incoming, Outgoing, 
Active, Held, Remote Held, 
Detached, Released, null 

Incoming 

Personality Originator flag of the call Integer (0, 1, -1) 

0 = BroadWorks 

1 = User 

-1 = null 

0 

Remote Name External caller name String or null null 

Remote Number External caller number String or null 5555551234 

Last Redirected Name Last redirected name String or null Jane Doe 

Last Redirected Number Last redirected number String or null null 

Time Date stamp of record Long Date/Time Format 2008-04-03 12:08:17.859 
 

NOTE:  Each row in the archive file records a single event change and as such, columns like 
Availability, ACD State, and Call State may contain null values since an alternate column value 
caused the event change.  For example, Wrap-Up is stored in ACD State while Call State (and 
other columns) store null. 

mailto:jsmith@abc.net


 
 

2.2.4 Call Center – Supervisor Tab  

Use the Call Center – Supervisor tab to configure your settings as a Call Center 
supervisor. 

 

Figure 32  Options Dialog – Supervisor Screen 

The following Supervisor Monitoring Accounts labels correspond with the columns: 

 Call Center displays the phone number of Call Center assigned to you.  For 
information on assigning Call Centers, refer to the BroadWorks Application Server 
Group Web Interface Administration Guide (Parts 1 and 2). 

 Monitored is your status in Call Center.  The login states are as follows:  Green is 
logged in.  Red means your last login failed.  Grey indicates you are not logged in. 

 Password is the text field where you type the password used to log in to Call Center.  
This password must correspond to the password of Call Center on the BroadWorks 
web portal. 

 Check Save password if you wish to save your password for the next logins. 

Following is the Supervisor Barge-In option. 

Use warning tone when barging in has the options of Yes or No.  If you wish to notify 
agents when a supervisor is barging in on a call, select “Yes”.  Otherwise, select “No”. 

BROADWORKS CALL CENTER AGENT/SUPERVISOR USER GUIDE 40-CA5904-00 
©2008 BROADSOFT, INC. PAGE 36 OF 97 



 
 

2.2.5 LDAP Integration Tab  

Use the LDAP Integration tab to configure your LDAP settings. 

Contact your system administrator if you do not know the appropriate settings. 

NOTE:  Make sure you have correctly imported a valid certificate in the Java Key Store (JKS) 
with the keytool using the following procedure: 

1. Click Start button and select “Run…”. 

2. Type “cmd” and click OK. 

3. Type “<Java Runtime Path>\bin\keytool -import -alias <aliasname> -file <path><certificate file 
name> -keystore %JAVA_HOME%\jre\lib\security\cacerts”. 

To verify the certificate: 

1. Click Start button and select “Run…”. 

2. Type “cmd” and click OK. 

3. Type “<Java Runtime Path>\bin\keytool -printcert -file <path><certificate file name>”. 

 

Figure 33  Options Dialog – LDAP Integration Screen 

The LDAP Directory options are as follows: 
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 Enable LDAP Integration determines whether Call Center provides LDAP directory 
lookup services.  Checking this box enables the controls on the Directory page. 

 Directory Address specifies the network address of the LDAP Directory server. 

 Port is the port number for the LDAP server.  This is compulsory and can be obtained 
from your system administrator. 

 Search Base determines the location in the directory server tree that Call Center looks 
in when executing a search. 

 Recursive, when checked, searches all sub-trees within the search base until the 
specifications are found. 

 Use SSL (Secure Sockets Layer) determines whether Call Center uses SSL to 
connect to the directory server.  Note that enabling SSL may require the use of a 
different port. 

 Requires Authentication indicates whether Call Center must provide a user name and 
password to the directory server to conduct searches. 

 Authenticated DN is the user name Call Center uses when connecting to the directory 
server when Requires Authentication is checked. 

 Authenticated Password corresponds to the Authentication DN. 

 Search Filter specifies an additional search filter to apply to all directory searches.  For 
example, to include the search criteria in the filter you must include 
(cn=*__SEARCH_TEXT__*).  Alternatively, in another example, 
“(telephoneNumber=*)” restricts search results to users who have a telephone 
number assigned. 

 Retrieved attributes is a table that controls the way that Call Center maps attributes 
returned from the directory server to columns displayed in the list of search results. 

 In each row of the table, enter an LDAP attribute in the Remote Name column.  In the 
Local Name column, enter a corresponding local attribute.  Typical Remote Name 
values are:  “cn”, “sn”, “telephoneNumber”, “mobile”, “homePhone”, “mail”. 

 



 
 

2.2.6 Outlook Integration Tab  

Click on the Outlook Integration tab to enable and disable the use of Microsoft Outlook 
with Call Center.  As of Outlook 2007 you are unable to dial a contact in your “in” box 
using the right click-to-dial function. 

 

Figure 34  Options Dialog – Outlook Integration Screen 

 The Enable Outlook Integration check box, when checked, makes sure that the 
Outlook integration features are activated.  When unchecked, the toolbar is 
unavailable within Outlook and you are unable to dial contacts directly. 

 The Retrieve contacts from default contact folder only option searches for and 
retrieves contacts stored in the default Contacts folder within Outlook. 

 The Retrieve all contacts option searches for and retrieves contacts stored in any 
Outlook folder. 

 Use Outlook contacts as preferred CLID lookup (for incoming calls) when checked, 
uses the information saved in your Outlook contact list when displaying information 
about callers, instead of using group settings or other calling line ID information. 

2.2.7 Web Screen Pop Tab  

The Web Screen Pop screen allows you to configure a web screen that you can open 
from the Call Notification window. 
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Figure 35  Options Dialog – Web Screen Pop Screen 

The Web Screen Pop URL determines the URL that Call Center Agent/Supervisor opens 
using the default browser when you click Web Screen Pop in the call notification popup 
window.  In addition to the URL, there are a number of optional parameters that the client 
can pass to the browser.  The following list summarizes these parameters: 

 __USER__:  The user’s BroadWorks ID.  (Note that in this case the “user” is the 
BroadWorks subscriber.) 

 __FIRST__:  The first name of the user. 

 __LAST__:  The last name of the user. 

 __EMAIL__:  The e-mail address of the user. 

 __GROUP__:  The name of the BroadWorks group the user belongs to. 

 __SERVICE_PROVIDER__:  The name of the BroadWorks service provider the user 
belongs to. 

 __PHONE__:  The phone number of the user. 

 __REMOTE_PHONE__:  The phone number of the remote party. 

 __REMOTE_NAME__:  The name of the remote party (when available). 

 __CALL_TYPE__:  “Incoming” or “Outgoing”. 

 

Auto pop incoming calls when checked, will launch the default browser web screen pop 
automatically, without the user being required to click the web screen pop-up icon in the 
call notification popup window for each incoming call. 
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2.2.8 Updates Tab  

Click on the Updates tab to configure the proxy information required to connect to a proxy 
server. 

 

Figure 36  Options Dialog – Updates Screen 

The Proxy Connection Settings options are as follows: 

 Use a proxy server to check for updates check box ensures that updates are 
automatically checked by a proxy server. 

 Type is the compulsory proxy server type.  Hypertext Transfer Protocol (HTTP) is the 
accepted form. 

 Server is the compulsory proxy server URL and can be obtained from the network 
administrator. 

 Port is the proxy server connection port number.  It is compulsory and can be 
obtained from the network administrator. 

 User ID is the authentication user ID that is required if user authentication is required 
by the proxy server. 

 Password is the authentication password that is required if user authentication is 
required by the proxy server. 
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2.2.9 About Tab  

Click on the About tab to find version information and read the general disclaimer for Call 
Center. 

 

Figure 37  Options Dialog – About Screen 

The information displayed is as follows: 

 BroadWorks Call Center Version 

 BroadWorks Call Center Disclaimer 

The About information is important in providing information for the purpose of technical 
support. 
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2.3 Change ACD States  
To change your availability status use the Available/Unavailable/Wrap-up buttons.  You 
can change your ACD states for each Call Center queue.  Click the Options – Agent 
dialog box to configure your initial ACD state as well as your ACD states for post calls. 

NOTE:  If the Available and Unavailable buttons are grayed out, contact your group 
administrator.  The group administrator may need to check the Allow Agent Logon check box on 
the BroadWorks Call Center web portal. 

2.3.1 Change Status to Available  

To change your status to available, click Available.  You are now available to receive calls 
in the Call Center. 

 

Figure 38  Available Button 

2.3.2 Change Status to Unavailable  

To change your status to unavailable, click Unavailable.  You are now unavailable to 
receive calls in the Call Center. 

 

Figure 39  Unavailable Button 

2.3.3 Change Status to Wrap-Up  

To change your status to wrap-up, click Wrap-Up.  Your call status has changed to wrap-
up (ending).  Wrap-up is only available if your pervious state was Available. 

 

Figure 40  Wrap-Up Button 
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2.4 Display Call Center Activity  
You can display Agent status and monitor contacts by completing the following 
instructions. 

2.4.1 Display Agent Status  

To display information about the status of Agents: 

Click View on the Menu panel.  From the drop-down list, select Monitoring. 

On the Team panel the agent’s name is listed as well as their Call State, Call Time, ACD 
State, ACD Time, and Caller ID. 

This information changes according to the Agent’s status. 

NOTE:  To de-select a queue, click the check box to remove the check mark. 

2.4.2 Monitor Queues  

To display information about the callers in a queue: 

Click View on the Menu panel.  From the drop-down list, check Monitoring. 

On the Call Center panel is a list of the queues.  If you are unable to see the calls in the 
queue and “Not Monitored” is displayed, follow the instructions detailed in section 2.2.4 
Call Center – Supervisor Tab. 

For information on repositioning callers in a queue, see section 2.11.1 Transfer Call to 
Queue. 



 
 

2.5 Display Directories  
You can display the following directories.  For specific directions, refer to the 
corresponding sections. 

2.5.1 Display Call History  

Use the Tools drop-down list and click on Call History. 

The Call History tab appears. 

 

Figure 41  Call History Tab 

2.5.1.1 Delete Call History 

You can delete all entries in the Call History tab.  To delete the call logs, do the following: 

Click the Clear button. 

 

Figure 42  Clear Button 

1) A warning message asks for your confirmation.  Select Yes. 
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Figure 43  Call History Confirmation Message 

The entries are now cleared. 

2.5.2 Display Contacts Directory  

Use the Directory drop-down list to make the Directory options visible. 

Select the Contacts Directory from the Directory drop-down list.  The Contact Directory tab 
is now visible. 

 

Figure 44  Contact Directory Tab 
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2.5.3 Display LDAP Directory  

Use the Directory drop-down list to make the Directory options visible. 

Select the LDAP Directory from the Directory drop-down list.  The LDAP Directory tab is 
now visible. 

 

Figure 45  LDAP Directory Tab 

2.5.4 Display Personal Directory  

Use the Directory drop-down list to make the Directory options visible. 

Select Personal Directory from the Directory drop-down list and check it.  The Personal 
Directory tab appears. 

 

Figure 46  Personal Directory Tab 

If the Personal Directory is not visible in the drop-down list or if you wish to add or edit 
entries, do this in the web portal.  For more information, see the BroadWorks Application 
Server User Web Interface Administration Guide. 

2.5.5 Display Outlook Directory  

Use the Directory drop-down list to make the Directory options visible. 

Select Outlook Directory from the Directory drop-down list and check it.  The Outlook 
Directory tab appears. 

 

Figure 47  Outlook Directory Tab 

2.5.6 Display Speed Dials Directory  

Use the Directory drop-down list to make the Directory options visible. 

Select Speed Dials Directory from the Directory drop-down list and check it.  The Speed 
Dials Directory tab appears. 

 

Figure 48  Speed Dials Directory Tab 

If the Speed Dials Directory is not visible in the drop-down list or if you wish to add or edit 
entries, do this in the web portal.  For more information, see the BroadWorks Application 
Server User Web Interface Administration Guide. 
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2.5.7 Search Directory  

To search for a contact within the directory, do the following: 

1) Type the contact information you want to search for in the text box.  Available criteria 
filters are:  Full name – a combination of the first and last name (default option), First 
name, Last name, Department, Phone number, or Notes.  The Phone number option 
searches for a matching contact’s extension number or mobile number. 

2) Click Search.  The directory displays the contacts that match the search criteria. 

 

Figure 49  Search Text Box 

NOTE:  To display the complete and unfiltered directory, click Reset (X). 
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2.6 Monitoring  
You can display the Monitoring tab.  This is only available to supervisors.  The Team panel 
shows real-time states of the agents managed by the supervisor as well as the 
supervisor’s own status. 

 

Figure 50  Monitoring Tab 

The following is detailed information about the panels: 

 The Team panel is located at the top of the tab.  It shows real-time states of the 
agents managed by the supervisor. 

− Name is the full name of the agent. 

− Call State is the call status of the agent.  The following icons represent each 
different state: 

Call State Icon Description 

Green Handset Down  Agent phone is on-hook (idle, free) 
(previously this was a green triangle). 

Red Handset Up  Agent phone is off-hook (talking, busy) 
(previously this was a red triangle). 

Orange Handset Down  Agent phone is ringing 
(previously this was a blue triangle). 

Do Not Disturb  Agent has status set to DND 
(previously this was an orange triangle). 

Grey Handset Down  Agent call state is currently unavailable or unknown 
(previously there was no triangle or it was blank). 

Private  Agent phone monitoring state is set to private. 

Call Forward Always 
 

Agent has status set to Call Forward Always (hovering 
the mouse over this icon displays the Call Forward 
Always number). 

 
− Call Time is the time elapsed since monitoring in the current call state. 
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− ACD State is the ACD state  of the agent.  This following icons represent each 
different state: 

ACD State Icon Description 

Sign In 
 

Agent is signing in.  This state is a temporary state 
while logging into the Call Center Agent client.  
However it may be selected as a permanent state if 
using the Call Center Express Agent (via web portal).  
This is not recommended. 

Available 
 

Agent is available to receive ACD calls 
(agents can also receive direct calls). 

Unavailable 
 

Agent is unavailable to receive ACD calls 
(agent can still receive direct calls). 

Wrap Up 
 

Agent is performing post-call work. 

Sign Out 
 

Agent is signed out. 

 
− ACD Time is the time elapsed since monitoring in the current ACD state. 

− CLID is the Caller ID number of the party the agent is in ringing, talking, or held 
state with. 

NOTE:  In some cases the agent’s ACD state could be blank if the agent did not initially update 
their status or has not changed it for some time. 

 The Call Centers panel is located at the bottom of the window.  It shows the Call 
Centers the supervisor is managing.  This is resizable. 

The supervisor of each Call Center can expand the Call Centers they manage by 
clicking the plus icon.  The expanded row displays the first 25 calls in the queue. 

NOTE:  If you are a supervisor of Call Center A but not of Call Center B, you can only expand 
Call Center A.  You can only expand the Call Centers you manage. 

The expanded table columns are: 

− Caller Name is the network name of the caller in the queue (if provided). 

− Caller ID is the network number of the caller in the queue (if provided). 

− Wait In Queue is the ACD state of the agent. 

The Call Center panel columns are: 

− The Call Center Name is the name of the Call Center. 

− Number is the phone number of the Call Center. 

− VM displays an envelope icon if that particular Call Center has voice mail 
messages.  The envelope is visible until there are no voice mail messages left. 

− Calls In Queue shows the amount of calls queued as a ratio of the total queue 
capacity for that Call Center. 

At the bottom of the Call Center panel there are three options.  These are: 
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− Retrieve retrieves a call to the supervisor’s device. 

− Queue Transfer, when clicked, provides a drop-down list of other Call Centers 
managed by the supervisor that the current call can be transferred to. 

− Reorder provides a drop-down list of positioning options for reordering the caller 
in the queue.  You can select Send to front which sends the call to the front of the 
queue or the nearest position.  Send to back sends the call to the back of the 
queue or the nearest position.  Range of 1-n sends the call to a specific position in 
the queue (n is the number of calls in the queue). 

 

2.7 Dashboard  
You can display the Dashboard tab.  This shows a summary of statistics on a per-Call 
Center basis.  Each ACD or queue is monitored as well as agents.  You must be a 
supervisor for this option. 

2.7.1 Display Dashboard  

To make the dashboard visible: 

Go to View on the Menu panel.  From the drop-down list, check Dashboard.  It is now 
visible as a tab. 

 

Figure 51  Dashboard Tab 

The Dashboard contains the components in the following sub-sections. 

2.7.2 Chart Information for Dashboard  

The Queue Summary shows the key performance indicators for each Call Center the 
supervisor manages. 
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NOTE:  It is recommended that all the agents for the Call Center are assigned to the supervisor 
so the Queue Summary table is more accurate.  Only metrics for agents assigned to the 
supervisor are shown in the table. 

The Agent Summary shows the real-time key performance indicators for the supervised 
team of agents.  The statistical measures are shown in the following table: 

Statistic Description Calculation 

Total Agents Staffed The ratio of logged-in agents managed by the 
supervisor divided by the total number of 
agents managed by the supervisor for this 
Call Center. 

count(All managed agents 
not in {ACD State is Sign-
Out}) over total managed 
agents 

Agents Available The number of agents currently showing 
Available as their ACD state 

count(All agents in {ACD 
State is Available}) 

Agents Unavailable The number of agents currently showing 
Unavailable as their ACD state. 

count(All agents in {ACD 
State is Unavailable}) 

Agents in Wrap-Up The number of agents currently showing 
Wrap-Up as their ACD state. 

count(All agents in {ACD 
State is Wrap-Up}) 

Agents Ringing The number of agents in Ringing phone state. count(All agents in {Call 
State is Alerting}) 

Agents on ACD Calls The number of agents in Talking phone state 
on calls distributed from the ACD. 

count(All agents in {Where 
callCenterUserID is not null}) 

Table 1  Dashboard Agent Summary 

2.7.3 Queue Summary Table Information  

The Queue Summary Table has the following columns: 

Statistic Description Calculation 

Call Center The names of the Call Centers the supervisor 
has access to. 

Not applicable 

Queued Calls The number of calls that are queued in that 
Call Center. 

count(Calls In Queue) as 
ratio of Queue Length 

Average Wait Time The average time a caller has been waiting in 
the queue. 

sum(Calls In Queue 
Time)/count(Call In 
Queue) 

Agent Staffed The ratio of logged in agents managed by the 
supervisor, divided by the total number of 
agents managed by the supervisor for this Call 
Center. 

count(All managed 
agents not in {ACD State 
is Sign-Out}) over total 
managed agents for Call 
Center 

Agents Available The number of agents in Available ACD state. count(All agents in {ACD 
State is Available}) 

Agents Unavailable The number of agents currently in Unavailable 
ACD state. 

count(All agents in {ACD 
State is Unavailable}) 

Agents Ringing The number of agents in Ringing phone state. count(All agents in 
{Where Call State is 
Alerting }) 
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Statistic Description Calculation 

Agents ACD Calls The number of agents in Talking phone state 
on calls distributed from the ACD. 

count(All agents in 
{Where callCenterUserID 
is not null}) 

Calls Abandoned The number of callers who have terminated 
the call while waiting in queue. 

count(Where 
updateReason equals 
CallAbandoned) 

% Within Service Level The percentage of calls that was answered 
within a pre-defined period of time.  This is 
shown in minutes and seconds (mm:ss). 

count(Where 
updateReason equals 
CallAnswered AND 
(Where Calls In Queue 
Time are less than 
Service Level 
Time)/count(Calls to 
Queue) 

Table 2  Dashboard Queue Summary 
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2.8 Reports  
The following reports are made visible to supervisors only, unless stated otherwise.  For 
detailed information, refer to the corresponding sections. 

From the bottom section of each report you are able to: 

 Click Print to print the report.  This opens a new browser and includes charts and 
tables. 

 Click Reset to reset the report criteria. 

 Click Refresh to refresh the report with the most current data.  This is only available 
on real-time reports. 

 Click Export to Excel to export the report to a Microsoft Excel compatible XML 
spreadsheet file.  No charts are exported in this file.  By clicking on the button’s drop-
down list you can also select Export to CSV, which exports the data to a semi-colon 
separated file. 

2.8.1 Export to CSV  

The Export to CSV option prompts the user to save the CSV file in a location on their 
machine.  This file can be opened using Microsoft Excel or a text editor. 

All statistic labels and corresponding values are encapsulated in double quotes as shown 
in the following sample CSV output: 

1   "Start Date/Time:","Thu Apr 17 00:00:00 GMT+1000 2008" 
2   "End Date/Time:","Fri Apr 18 01:07:47 GMT+1000 2008" 
3   "Call Center(s):","myACD1" 
4   "Service Level:","00:10" 
5   
6   Queue Activity - All Call Centers - Hourly 
7   "Call Center","Calls Received","Calls Answered","Calls in 
Queue","Calls Abandoned","Calls Overflowed" 
8   "myACD1","20","9","0","11","0" 
9   "Summary","20","9","0","11","0" 
10 
11  Queue Summary - All Call Centers - Hourly 
12  "Call Center","Avg Wait Time","Avg Speed Answer","Avg Abandonment 
Time","Avg Staff" 
13  "myACD1","00:28","00:36","00:34","1" 
14  "Summary","00:28","00:36","00:34","1" 
15 
16  Queue Performance - All Call Centers - Hourly 
17  "Call Center","% Answered","% Calls in Queue","% Abandoned","% Within 
Service Level" 
18  "myACD1","47%","0%","52%","23%" 
19  "Summary","47%","0%","52%","23%" 

Figure 52  Export to CSV Sample File 

The following key elements are used in the sample above: 

 Report header information is provided in lines 1 through 4 

 Table group headers are used (without double quotes) in lines 6, 11, and 16 

 Table column headers are used in lines 7, 12, and 17 

 Data for each column header is listed under each corresponding column. 
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2.8.2 Time Allocation Matrix  

Statistical measures are calculated based on the following logic: 

ACD State Call State State/Time Allocation Handle Time 

Idle Available Time  

Talking Talk Time 

Available 

Hold Hold Time 

Handle Time 

Wrap-up Idle Wrap-up Time  

Unavailable Any Unavailable Time  

Table 3  Time Allocation Matrix for Agent Statistics 

NOTE 1:  In report data, if there is a dash, this means there is no time documented.  “0:00” 
means the task took zero seconds to complete. 

NOTE 2:  The average and percentage summary in the Reports tables is the mean of all values 
in that particular column and not an aggregate.  However for all other statistics, the summary 
represents the sum of the values for that column. 

For example: 

Average Summary = (Avg1 + Avg2) / 2 

OR 

Percentage Summary = (Perc1 + Perc2  + Perc3) / 3 



 
 

2.8.3 Agent Activity Report  

The Agent Activity Report displays metrics related to agents’ call handling activity for a 
given Call Center.  The heading for this report is Agent Activity – Agent Full Name – 
Interval, for example, Agent Activity – All Agents – Half Hourly Report.  This can also be 
set to view an individual agent. 

 

Figure 53  Agent Activity Report 

2.8.3.1 Display Agent Activity Report 

To display the Agent Activity Report, complete the following procedure: 

1) Click on the View menu.  Use the Reports drop-down list to display the reports. 

2) Select the Agent Activity Report from the drop-down list and click on it.  The Agent 
Activity tab appears. 

3) Fill in the following details: 

Input Field Description Allowed Value Default Value 

Report Type This can be checked as Historical or Real Time.  Historical 
reports are a summary of the assigned start date to the 
assigned end date.  Real-time reports are refreshed at 
regular intervals and show a summary from the start date 
to the present.  The default refresh time is five minutes 
and can be changed to a minimum of one minute using 
Deployment Studio.  For more information, see 
BroadWorks Deployment Studio User Guide for Call 
Center. 

Historical or 
Real-time 

Historical 

Hour Type Allows you to check how you would like to see the time, 
either in A.M., P.M., or Military style. 

AM/PM or 24hrs AM/PM 

Start Date This is the date when you want the report to start from.  It 
can be set by typing in the text box or clicking on the 
Calendar icon.  This is compulsory.  The maximum 
historical date is 179 days prior. 

MMM DD, YYYY Current Date 
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Input Field Description Allowed Value Default Value 

Start Time This is the time when you want the report to start from.  
You can select the hour format (A.M., P.M., or Military 
time) from the Hour Selection Type.  Time is applicable for 
hourly and minute intervals only. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 

End Date This is the date when you want the report to end.  It can 
be set by typing in the text box or clicking on the Calendar 
icon.  This is compulsory when a Historical report is 
selected. 

MMM DD, YYYY Current Date 

End Time This is the time when you want the report to end.  You can 
select the hour format (A.M., P.M., or Military time) from 
the Hour Selection Type.  Time is applicable for hourly and 
minute intervals only.  This is compulsory if a Historical 
report is selected. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 

Interval This determines how you would like the information 
displayed.  The drop-down list options are Monthly, Daily, 
Hourly, and Half Hourly.  Daily and Monthly intervals are 
shown in days, hours, minutes, and seconds 
(dd:hh:mm:ss).  Hourly and Half Hourly are shown in 
minutes and seconds (mm:ss).  The minimum historical 
interval is half an hour for the previous hour. 

Half Hourly, 
Hourly, Daily, 
Monthly 

Half Hourly 

Agent Allows you to select a specific agent from the drop-down 
list or all Call Centers. 

NOTE:  An agent can only select themselves from this drop-down list.  
However a supervisor has access to Each Managed Agent and All 
Agents options. 

Each Managed 
Agent or All 
Agents 

All Agents 

 
4) Click Display to expand and reset the report. 

2.8.3.2 Chart Information for Agent Activity Report 

The following table describes the graph information on the Agent Activity Report, from left 
to right: 

Statistic Description 

Number of Calls by Call Type (Pie Chart) 

ACD The percentage of ACD calls that an agent has answered during the 
specified interval. 

Inbound The percentage of direct non-ACD calls that an agent answered during 
the specified interval. 

Outbound The percentage of outbound calls that an agent made during the 
specified interval. 

NOTE:  This includes calls that were made while performing Consult Transfer, Escalate, 
and Conference. 

Call Duration by Call State (Pie Chart) 

Wrap-Up The percentage of call duration that an agent spent in Wrap-Up state 
during the specified interval. 

Unavailable The percentage of call duration that an agent spent in Unavailable state 
during the specified interval. 

Available The percentage of call duration that an agent spent in Available state 
during the specified interval. 
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Statistic Description 

Call Duration by Call Type (Vertical Bar Chart) 

ACD The duration of time in minutes and seconds that an agent spent 
answering ACD calls during the specified interval. 

Inbound The duration of time in minutes and seconds that an agent spent 
answering direct non-ACD calls during the specified interval. 

Outbound The duration of time in minutes and seconds that an agent spent making 
outbound calls during the specified interval. 

NOTE:  This includes calls that were made while performing Consult Transfer, Escalate, 
and Conference. 

 

2.8.3.3 Table Information for Agent Activity Report 

The following table describes the columns on the Agent Activity Report, from left to right.  
Where applicable, calculations are provided for statistics that are derived from other fields: 

Statistic Description 

Call Duration by Call State 

First Name The first name of an agent.  This is not the CLID name. 

Last Name The last name of an agent.  This is not the CLID name. 

Available The time during the specified interval that an agent was in the Available 
state. 

Unavailable The time during the specified interval that an agent was in the 
Unavailable state. 

Wrap-Up The time during the specified interval that an agent was in the Wrap-Up 
state. 

Talk The time during the specified interval that an agent spent in the On Call 
state. 

Hold The time during the specified interval that an agent spent in the Hold 
state. 

Idle The time during the specified interval that an agent spent idle in the 
Available state.  The agent is considered idle if they are not on an ACD 
call. 

Staffed The time during the specified interval that an agent spent not in the 
Signed-Out state. 

Number of Calls by Call Type 

First Name The first name of an agent.  This is not the CLID name. 

Last Name The last name of an agent.  This is not the CLID name. 

ACD The number of ACD calls that were answered by an agent during the 
specified interval. 

Inbound The number of direct non-ACD calls answered by an agent.  

Outbound The number of outbound calls an agent made during the specified 
interval. 

Call Duration by Call Type 

First Name The first name of an agent.  This is not the CLID name. 
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Statistic Description 

Last Name The last name of an agent.  This is not the CLID name. 

ACD The duration of ACD calls answered by an agent during the specified 
interval. 

Inbound The duration of direct non-ACD calls an agent answered during the 
specified interval. 

Outbound The duration of outbound calls an agent spent making during the 
specified interval. 

 



 
 

2.8.4 Agent Utilization Report  

The Agent Activity Report displays metrics related to agents’ call performance for a given 
Call Center.  The heading for this report is Agent Utilization – Agent Full Name – Interval, 
for example, Agent Utilization – All Agents – Half Hourly Report.  This can also be set to 
view an individual agent. 

 

Figure 54  Agent Utilization Report 

2.8.4.1 Display Agent Utilization Report 

To display the Agent Utilization Report, complete the following procedure: 

1) Click on the View menu.  Use the Reports drop-down list to display the reports. 

2) Select Agent Utilization from the Report drop-down list.  The Agent Utilization tab 
appears. 

3) Fill in the following details: 

Input field Description Allowed Values Default Value 

Report Type Can be checked as Historical.  Historical reports are a 
summary of the assigned start date to the assigned end 
date. 

Historical Historical 

Hour Type Allows you to check how you would like to see the time, 
either in A.M./P.M. or in Military time. 

AM/PM or 24hrs AM/PM 

Start Date When you want the report to start from.  It can be set by 
typing in the text box or clicking on the Calendar icon.  
This is compulsory.  The maximum historical date is 179 
days prior to this date. 

MMM DD, YYYY Current Date 

Start Time When you want the report to start from.  You can select 
the hour format (A.M./P.M. or Military time) from the Hour 
Selection Type.  Time is applicable for hourly and minute 
intervals only. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 
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Input field Description Allowed Values Default Value 

End Date When you want the report to end.  It can be set by typing 
in the text box or clicking on the Calendar icon.  This is 
compulsory if a Historical report is selected. 

MMM DD, YYYY Current Date 

End Time When you want the report to end.  You can select the 
hour format (A.M./P.M. or Military time) from the Hour 
Selection Type.  Time is applicable for hourly and minute 
intervals only.  This is compulsory if a Historical report is 
selected. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 

Interval How you would like the information displayed.  The drop-
down list options are Monthly, Daily, Hourly, and Half 
Hourly.  Daily and Monthly intervals are shown in days, 
hours, minutes, and seconds (dd:hh:mm:ss).  Hourly and 
Half Hourly are shown in minutes and seconds (mm:ss).  
The minimum historical interval is half an hour for the 
previous hour. 

Half Hourly, 
Hourly, Daily, 
Monthly 

Half Hourly 

Agent Allows you to select a specific agent from the drop-down 
list or all agents. 

Each Managed 
Agent or All 
Agents 

All Agents 

 
4) Click the Display button to display and expand the report. 

2.8.4.2 Chart Information for Agent Utilization Report 

The following table describes the graph information in the Agent Utilization Report, from 
left to right: 

Statistic Description 

Agent Call Summary (Pie Chart) 

ACD Calls The percentage of ACD calls that was answered by an agent during 
the specified interval. 

Inbound Calls The percentage of direct non-ACD calls that were answered by an 
agent during the specified interval. 

Outbound Calls The percentage of outbound calls that an agent made during the 
specified interval. 

NOTE:  This includes calls that were made while performing Consult Transfer, 
Escalate, and Conference. 

Held Calls The percentage of ACD calls that an agent held during the specified 
interval. 

Agent Call Summary by Call Type (Pie Chart) 

Avg ACD Duration The duration percentage that an agent spent answering ACD calls 
during the specified interval. 

Avg Inbound Duration The duration percentage that an agent spent answering direct non-
ACD calls. 

Avg Outbound Duration The duration percentage that an agent spent making outbound calls. 

NOTE:  This includes calls that were made while performing Consult Transfer, 
Escalate, and Conference. 

Agent Performance (Line Chart) 

Avg ACD Time The average time in minutes and seconds that an agent spent 
answering ACD calls during the specified interval. 
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Statistic Description 

Avg Sign-in Time The average time in minutes and seconds that an agent took to sign in 
to a Call Center. 

Avg Wrap-Up Time The average time in minutes and seconds that an agent took to wrap 
up ACD calls. 

Avg Talk Time The average time in minutes and seconds that an agent spent on calls. 

Avg Hold Time The average time in minutes and seconds that an agent spent on hold. 

Avg Handle Time The average time in minutes and seconds that an agent spent handling 
a call. 

 

2.8.4.3 Table Information for Agent Utilization Report 

The following table describes the columns in the Agent Utilization Report, from left to right. 
Where applicable, calculations are provided for statistics that are derived from other fields: 

Statistic Description 

Agent Call Summary 

First Name The first name of an agent.  This is not the CLID name. 

Last Name The last name of an agent.  This is not the CLID name. 

ACD Calls The number of ACD calls that an agent answered during the specified 
interval. 

Inbound Calls The number of direct non-ACD calls that an agent answered during 
the specified interval. 

Outbound Calls The number of outbound calls that an agent made during the 
specified interval. 

NOTE:  This includes calls that were made while performing Consult Transfer, 
Escalate, and Conference. 

Held Calls The number of ACD calls that an agent held during the specified 
interval. 

Agent Call Summary by Call Type 

First Name The first name of an agent.  This is not the CLID name. 

Last Name The last name of an agent.  This is not the CLID name. 

Avg ACD Time The average length of ACD calls during the specified interval. 

Avg ACD Time = Total ACD Call Time/ACD Calls 

Avg Inbound Time The average length of direct non-ACD during the specified interval. 

Avg Inbound Time = Total Inbound Call Time/Inbound Calls 

Avg Outbound Time The average length of outbound calls that an agent made during the 
specified interval. 

Avg Outbound Time = Total Outbound Call Time/Outbound Calls 

NOTE:  This includes calls that were made while performing Consult Transfer, 
Escalate, and Conference. 

Agent Performance 

First Name The first name of an agent.  This is not the CLID name. 

Last Name The last name of an agent.  This is not the CLID name. 
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Statistic Description 

Avg ACD Time The average duration of an agent’s ACD calls that includes the ring 
time, talk time, and hold time of each ACD call during the specified 
interval. 

Avg ACD Time = Total ACD Call Time/ACD Calls 

Avg Sign-In Time The average time in minutes and seconds that an agent took to sign 
into a Call Center during the specified interval. 

Avg Sign-In Time = Total Signed In Time/Num Sign-In 

Avg Wrap-Up Time The average time in minutes and seconds it took an agent to wrap up 
during the specified interval. 

Avg Wrap-Up Time = Total Wrap-Up Time/Num Wrap-Up 

Avg Talk Time The average of an agent’s talk time in minutes and seconds that 
excludes ring time during the specified interval. 

Avg Talk Time = Total Talk Time/ACD Calls 

Avg Hold Time The average of an agent’s hold time in minutes and seconds during 
the specified interval. 

Avg Hold Time = Total Hold Time/ACD Calls 

Avg Handle Time This is the average of an agent’s handle time, in minutes and 
seconds, during the specified interval. 

Avg Handle Time Handle = Total Talk Time + Total Hold Time + Total Wrap-Up 
Time)/ACD Calls 

NOTE:  For more information see, section 2.8.2 Time Allocation Matrix. 
 



 
 

2.8.5 Queue Performance Analysis Report  

The Queue Performance Analysis Report displays metrics related to the performance of a 
Call Center ACD.  The heading for this report is Queue Performance Analysis – Call 
Center Name – Interval Report, for example, Queue Performance Analysis – Support – 
Half Hourly Report.  This can be changed to view “All Call Centers”. 

 

Figure 55  Queue Performance Report 

2.8.5.1 Display Queue Performance Analysis Report 

To display the Queue Performance Analysis Report, complete the following procedure: 

1) Click on the View menu.  Use the Reports drop-down list to display the reports. 

2) Select the Queue Performance Analysis Report from the drop-down list and click on it.  
The Queue Performance Analysis Report tab appears. 

3) Fill in the following details: 

Input Field Description Allowed Value Default Value 

Report Type This can be checked as Historical or Real Time.  
Historical reports are a summary of the assigned 
start date to the assigned end date.  Real-time 
reports are refreshed at regular intervals and 
show a summary from the start date to the 
present.  The default refresh time is five minutes 
and can be changed to a minimum of one 
minute using Deployment Studio.  For more 
information, see BroadWorks Deployment 
Studio User Guide for Call Center. 

Historical or 
Real-time 

Historical 

Hour Selection Type Check how you would like to see the time, either 
in A.M./P.M. or in Military time. 

AM/PM or 
24hrs 

AM/PM 
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Input Field Description Allowed Value Default Value 

Start Date When you want the report to start from.  It can 
be set by typing in the text box or clicking on the 
Calendar icon.  This is compulsory.  The 
maximum historical date is 179 days prior to this 
date. 

MMM DD, 
YYYY 

Current Date 

Start Time When you want the report to start from.  You can 
select the hour format (A.M./P.M. or Military 
time) from the Hour Selection Type.  Time is 
applicable for hourly and minute intervals only. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 

End Date When you want the report to end.  It can be set 
by typing in the text box or clicking on the 
Calendar icon.  This is compulsory if a Historical 
report is selected. 

MMM DD, 
YYYY 

Current Date 

End Time When you want the report to end.  You can 
select the hour format (A.M./P.M. or Military 
time) from the Hour Selection Type.  Time is 
applicable for hourly and minute intervals only.  
This is compulsory if a Historical report is 
selected. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 

Interval How you would like the information displayed.  
The drop-down list options are Monthly, Daily, 
Hourly, and Half Hourly.  Daily and Monthly 
intervals are shown in days, hours, minutes, and 
seconds (dd:hh:mm:ss).  Hourly and Half Hourly 
are shown in minutes and seconds (mm:ss).  
The minimum historical interval is half an hour 
for the previous hour. 

Half Hourly, 
Hourly, Daily, 
Monthly 

Half Hourly 

Acceptable Service Level This can be dragged to the acceptable amount 
of time that calls must be answered by.  This is 
defined in seconds.  The slider has a range of 0 
to 3600 seconds.  The slider converts this to 
minutes and seconds (mm:ss). 

mm:ss 00:00 

Call Center Allows you to select a specific Call Center from 
the drop-down list or all Call Centers. 

Each Managed 
Call Center or 
All Call Centers 

All Call Centers 

 
4) Click Display to expand and reset the report. 

2.8.5.2 Chart Information for Queue Performance Report 

The following table describes the graph information on the Queue Performance Analysis 
Report, from left to right: 

Statistic Description 

Queue Activity (Pie Chart) 

Calls Answered The percentage of calls that were answered by the Call Center. 

Calls In Queue The percentage of calls that were in the Call Center queue. 

Calls Overflowed The percentage of calls that exceeded the queue length of the Call Center. 

Calls Abandoned The percentage of calls that were abandoned while waiting in the Call 
Center queue. 

Queue Summary (Line Chart) 

Avg Wait Time The average wait time or delay in minutes and seconds a call was in the 
queue of the Call Center. 
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Statistic Description 

Avg Speed Answer The average time in minutes and seconds that a call was answered in the 
Call Center. 

Avg Abandonment Time The average time in minutes and seconds that a call was abandoned while 
waiting in the Call Center queue. 

Queue Performance (Horizontal Bar Chart) 

% Answered The percentage of calls that was answered by the Call Center. 

% In Queue The percentage of calls in the Call Center queue. 

% Abandoned The percentage of calls that was abandoned while waiting in the Call 
Center queue. 

% Within Service Level The percentage of calls that was within the designated service level of the 
Call Center. 

2.8.5.3 Table Information for Queue Performance Report 

The following table describes the columns in the Queue Performance Analysis Report: 

Statistic Description 

Queue Activity 

Call Center The list of Call Centers that the supervisor is monitoring and managing. 

Calls Received The number of calls that were placed to the queue. 

NOTE:  Total Calls = Calls Received + Calls Overflowed = (Calls Answered + Calls In 
Queue + Calls Abandoned) + Calls Overflowed. 

Calls Answered The total calls answered by agents. 

Calls In Queue The number of calls that are in the queue. 

Calls Abandoned The number of calls that are abandoned by the caller when calls are in 
queue or when calls are ringing for agent. 

NOTE:  Calls Abandoned includes calls that are forwarded to voice mail if the caller decides 
to press “0” to leave a message (as configured for the Call Center, Voice Messaging User 
settings) and calls that are forwarded from the queue after waiting X seconds (as configured 
for the Call Center Profile, No Answer settings). 

Calls Overflowed The number of calls that were transferred to voice mail or given a busy 
tone because the queue overflowed. 

Queue Summary 

Call Center The list of Call Centers that the supervisor is monitoring and managing. 

Avg Time In Queue The average wait time or delay in queue excluding ring time displayed in 
minutes and seconds. 

Avg Time In Queue = Total Queue Time/Calls Answered 

Avg Speed Answer The time between alerting and talking states in minutes and seconds. 

Avg Speed = (Total Queue Time + Total Ring Time)/Calls Answered 

Avg Abandonment Time The average time a caller is in the queue before hanging up displayed in 
minutes and seconds. 

Avg Abandonment Time = Total Abandonment Time/Calls Abandoned 

Avg Staff The average number of agents who are not signed out of the queue during 
the reporting interval. 

Avg Staff = Staff Time/Specified Interval 
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Statistic Description 

Queue Performance 

Call Center The list of Call Centers that the supervisor is monitoring and managing. 

% Answered The percentage of calls that was answered by the Call Center. 

% Answered = Calls Answered/Calls Received 

% In Queue The percentage of calls that are in the Call Center queue. 

% In Queue = Calls In Queue/Calls Received 

% Abandoned The percentage of calls that was abandoned while waiting in the Call 
Center queue. 

% Abandoned = Calls Abandoned/Calls Received 

% Within Service Level The percentage of calls that was within the designated Service Level of the 
Call Center. 

% Within Service Level = Calls Answered In Service Level N/Calls Answered 
 



 
 

2.8.6 Service Level Report  

The Service Level Report is also known as a Grade of Service Report and displays 
metrics related to the speed of answer for ACD calls.  The heading for this report is 
Service Level – Call Center Name – Interval Report, for example, Service Level – All Call 
Centers – Half Hourly Report.  This can be changed to view a single Call Center. 

 

Figure 56  Service Level Report 

2.8.6.1 Display Service Level Report 

To display the Service Level Report, complete the following procedure: 

1) Click on the View menu.  Use the Reports drop-down list to display the reports. 

2) Select the Service Level Report from the drop-down list and click on it.  The Service 
Level Report tab appears. 

3) Fill in the following details: 

Input Field Description Allowed Values Default Values 

Report Type Can be checked as Historical.  Historical reports are 
a summary of the assigned start date to the 
assigned end date. 

Historical Historical 

Hour Type Check how you would like to see the time, either in 
A.M./P.M. or in Military time. 

AM/PM or 24hrs AM/PM 

Start Date When you want the report to start from.  It can be 
set by typing in the text box or clicking on the 
Calendar icon.  This is compulsory.  The maximum 
historical date is 179 days prior to this date. 

MMM DD, YYYY Current Date 

Start Time When you want the report to start from.  You can 
select the hour format (A.M./P.M. or Military time) 
from the Hour Selection Type.  Time is applicable for 
hourly and minute intervals only 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 
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Input Field Description Allowed Values Default Values 

End Date When you want the report to end.  It can be set by 
typing in the text box or clicking on the Calendar 
icon.  This is compulsory if a Historical report is 
selected. 

MMM DD, YYYY Current Date 

End Time When you want the report to end.  You can select 
the hour format (A.M./P.M. or Military time) from the 
Hour Selection Type.  Time is applicable for hourly 
and minute intervals only.  This is compulsory if a 
Historical report is selected. 

1-12 AM/PM or 
00-23 hr, 00-
59mins 

12am or 00 

Interval How you would like the information displayed.  The 
drop-down list options are Monthly, Daily, Hourly, 
and Half Hourly.  Daily and Monthly intervals are 
shown in days, hours, minutes, and seconds 
(dd:hh:mm:ss).  Hourly and Half Hourly are shown in 
minutes and seconds (mm:ss).  The minimum 
historical interval is half an hour for the previous 
hour. 

Half Hourly, 
Hourly, Daily, 
Monthly 

Half Hourly 

Number of Service Levels The number of service levels you would like to 
specify for the Call Center.  You can select from a 
range of one to five. 

1-5 5 

Service Level 1 – 5 This can be dragged to the acceptable amount of 
time that calls must be answered by.  This is defined 
in seconds.  The slider has a range of 0 to 3600 
seconds.  The slider converts this to minutes and 
seconds (mm:ss).  The default settings are “15”, 
“30”, “45”, “60”, and “75” seconds 

mm:ss 00:15 

00:30 

00:45 

1:00 

1:15 

Call Center Select a specific Call Center from the drop-down list 
or all Call Centers. 

Each Managed 
Call Center or All 
Call Centers 

All Call Centers 

 
5) Click Display to expand and reset the report. 

2.8.6.2 Chart Information for Service Level Report 

The following list describes the graph information in the Service Level Report, from left to 
right: 

Statistic Description 

Service Level (Line Chart) 

% Within Service Level The percentage of ACD calls that were answered by an agent within each 
service interval (this is the acceptable service level). 

2.8.6.3 Table Information for Service Level Report 

The following table describes the columns in the Service Level Report.  The columns are 
repeated according to the number of Service Levels selected: 

Statistic Description 

Service Level 

Call Center The list of Call Centers that the supervisor is monitoring and managing. 
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Statistic Description 

Average Wait Time The average wait time in queue during the specified interval.  This is 
repeated for each service level. 

Average Wait Time = Total Queue Time/Calls Answered 

Average Speed Answer The average speed to answer during the specified interval.  This is 
repeated for each service level. 

Average Speed Answer = (Total Queue Time + Total Ring Time)/Calls Answered 

Calls Handled The number of ACD calls answered by an agent between each service 
level interval.  This is repeated for each service level. 

% Within Service Level The percentage of ACD calls that were answered by an agent within each 
service interval. 

% Within Service Level = Calls Answered In Service Level N/Calls Answered 
 



 
 

2.9 Manage Calls  
You can make calls from an ad hoc number or the directories by using the workflow 
detailed in the following sub-sections. 

2.9.1 Dial Ad Hoc Number  

To make a call to an ad hoc number (a person not listed in your Contact Directory), do the 
following: 

1) Open the Dial Number text field.  Enter the number you wish to call either by typing 
the number on the keyboard or by selecting each number in turn from the dial pad 
using your mouse. 

2) Press Enter to place the call. 

3) To end the call, click the End button. 

 

Figure 57  End Button 

2.9.2 Re-Dialing Number  

Use the Dial Number combo box to select a previously dialed number: 

1) Select a number by clicking on the arrow at the right-hand side of the Dial Number 
box.  A list of up to 10 previously dialed numbers is displayed. 

2) Select a number in the list. 

3) Press Enter to place the call. 

4) To end the call, click the End button. 

 

Figure 58  End Button 
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2.9.3 Dial from Search  

Use the Search drop-down list to search for a user or contact. 

Your search returns all users that match your criteria in any field.  For example, if you 
enter “sa” as your criteria, your search might return users with the first name “Samuel” or 
“Sally”, users with the last name “Sawyer” and users in the department “Sales”.  You can 
also search for users by phone number. 

To search for a user: 

1) Type your search criteria in the Search box. 

2) Press Enter to execute the search. 

3) Click the phone number you want to dial. 

4) To end the call, click the End button. 

To re-execute a previous search: 

1) Select a previous search criterion by clicking on the arrow at the right-hand side of the 
Search box.  A list of previous search criteria is displayed.  Select an item in the list. 

2) Click the phone number you want to dial. 

3) To end the call, click the End button. 

 

Figure 59  End Button 
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2.9.4 Dial from Call History Directory  

You can dial any number stored in the Call History Directory. 

To use the Call History Directory to make a call: 

1) Select the Call History tab in the Tools drop-down menu.  The following should be 
displayed. 

 

Figure 60  Call History Tab 

This list can also be printed using the host application. 

2) Click the desired phone number.  The call is placed. 

To sort the Call History Directory search results, click a column header.  The table is 
sorted according to the information in the column you selected, in descending order.  Click 
again on the same column header to toggle the sort order between descending and 
ascending. 

NOTE:  Users with Microsoft Windows XP Service Pack 2 (SP2) installed may encounter a 
warning when opening the Call History Directory. 
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2.9.5 Dial from Contact Directory  

You can dial any number stored in your Contact Directory provider with Call Center. 

To use the Contact Directory to make a call: 

1) Select the Contact Directory tab.  The following should be displayed. 

 

Figure 61  Contact Directory Tab 

This list can also be printed using the host application. 

2) Click the desired phone number.  The call is placed. 

3) To refresh the directory, click Refresh. 

To sort the Contact Directory, click a column header.  The table is sorted according to the 
information in the column you selected, in descending order.  Click again on the same 
column header to toggle the sort order between descending and ascending. 

NOTE:  Users with Microsoft Windows XP Service Pack 2 (SP2) installed may encounter a 
warning when opening the Contact Directory. 

2.9.6 Dial from LDAP Directory  

You can directly dial any number stored in the LDAP Directory server. 

To use the LDAP Directory to make a call: 

1) Select the LDAP Directory tab.  The following should be displayed. 

 

Figure 62  LDAP Directory Tab 

This list can also be printed using the host application. 

2) Click the desired phone number.  The call is placed. 

To sort the LDAP Directory, click a column header.  The table is sorted according to the 
information in the column you selected, in descending order.  Click again on the same 
column header to toggle the sort order between descending and ascending. 

NOTE:  Users with Microsoft Windows XP Service Pack 2 (SP2) installed may encounter a 
warning when opening the LDAP Directory. 
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2.9.7 Dial from Outlook Directory  

You can dial any number stored in your Outlook Directory, which integrates your Outlook 
contacts with Call Center. 

To use the Outlook Directory to make a call: 

1) Click the Outlook Directory tab.  The following should be displayed. 

 

Figure 63  Outlook Directory Tab 

This list can also be printed using the host application. 

2) Click the desired phone number.  The call is placed. 

To sort the Outlook Directory, click a column header.  The table is sorted according to the 
information in the column you selected, in descending order.  Click again on the same 
column header to toggle the sort order between descending and ascending. 

NOTE:  Users with Microsoft Windows XP Service Pack 2 (SP2) installed may encounter a 
warning when opening the Outlook Directory. 

2.9.8 Dial from Personal Directory  

You can dial any number stored in your Personal Directory, which integrates your personal 
contacts with the Call Center. 

To use the Personal Directory to make a call: 

1) Click the Personal Directory tab.  The following should be displayed. 

 

Figure 64  Personal Directory Tab 

This list can also be printed using the host application. 

2) Click the desired phone number.  The call is placed. 

To sort the Personal Directory, click a column header.  The table is sorted according to the 
information in the column you selected, in descending order.  Click again on the same 
column header to toggle the sort order between descending and ascending. 

NOTE:  Users with Microsoft Windows XP Service Pack 2 (SP2) installed may encounter a 
warning when opening the Personal Directory. 
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2.9.9 Dial from Speed Dials Directory  

You can dial any number stored in your Speed Dials Directory. 

To use the Speed Dials Directory to make a call: 

1) Click the Speed Dials Directory tab.  The following should be displayed. 

 

Figure 65  Speed Dials Directory Tab 

This list can also be printed using the host application. 

2) Click the desired phone number.  The call is placed. 

To sort the Speed Dials Directory, click a column header.  The table is sorted according to 
the information in the column you selected, in descending order.  Click again on the same 
column header to toggle the sort order between descending and ascending. 

NOTE:  Users with Microsoft Windows XP Service Pack 2 (SP2) installed may encounter a 
warning when opening the Speed Dials Directory. 
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2.10 Manage Conference Calls  
To start a conference call: 

1) Dial a number on your phone or select a number using any of the methods described 
in section 2.8.6 Service Level Report.  Your active call is put on hold. 

2) Click Conference and select Start from the drop-down list. 

 

Figure 66  Conference Button Drop-down List 

NOTE:  When in Remote Office the Answer, Hold, and Escalate buttons are disabled. 

− To hold your phone on the conference call, select Hold from the Conference drop-
down list. 

− To return from the hold, select Unhold from the Conference drop-down list. 

− To leave the conference call, select Leave from the Conference drop-down list. 

− To terminate the conference call, select Terminate from the Conference drop-
down list. 

2.11 Manage Queues  
Using the instructions in the following sub-sections, you can transfer a call in and out of a 
queue, retrieve a call from a queue, and transfer a call between queues. 

2.11.1 Transfer Call to Queue  

You must be an agent to use this function.  To transfer a call into a queue: 

1) While on a call, select the destination queue from the drop-down list. 

2) Position the call in the queue by clicking the Transfer button. 
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Figure 67  Transfer Button 

3) Select the placement of the call from the Reorder drop-down list located on the bottom 
panel. 

 

Figure 68  Monitoring Tab 

4) Transfer the call by clicking the Transfer option on the Transfer button drop-down list. 

2.11.2 Position Call in Queue  

To change a call’s position in a queue: 

1) Select the call in the queue. 

2) Select the placement of the call from the Reorder drop-down list located on the bottom 
panel.  Click on the desired position. 

2.11.3 Retrieve Call from Queue  

You must be a supervisor to use this option.  To transfer a call from a queue to your 
phone: 

1) Select the queued call from the Queue Detail sub-table located in the Call Center 
panel’s Monitoring tab.  To make this visible, check the box in the View drop-down list. 

2) Click the Retrieve button. 

 

Figure 69  Retrieve Button 
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2.11.4 Transfer Call between Queues  

You must be a supervisor to use this option.  To transfer a call between queues: 

1) Select the queued call from the Queue Detail sub-table located in the Call Center 
panel’s Monitoring tab.  To make this visible, check the box in the View drop-down list. 

2) Select the target queue from the Queue Transfer drop-down list in the Call Center 
panel’s Monitoring tab.  This only allows transfers to the back of the queue. 

 

Figure 70  Monitoring Tab 

2.11.5 Transfer Call Out of Queue to New Number  

You must be a supervisor to use this option.  To transfer a call out of a queue to a new 
number: 

1) Select the queued call from the Queue Detail sub-table located in the Call Center 
panel’s Monitoring tab.  To make this visible, check the box in the View drop-down list. 

2) Click the Retrieve button. 

 

Figure 71  Retrieve Button 

3) The call is now visible on the switchboard.  Answer the retrieved call. 

4) Dial the destination number on your phone or select a number using any of the 
methods described in section 2.8.6 Service Level Report. 

5) Click the Transfer button.  From the drop-down list, select the destination number. 

 

Figure 72  Transfer Button 
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NOTE:  When in Remote Office the Answer, Hold, and Escalate buttons are disabled. 

2.12 Receive a Call  
This section contains detailed instructions on how to receive a call.  For more information 
on answering a call, doing a blind or consulted transfer, holding a call, saving a vCard, or 
opening a URL, refer to the corresponding sections. 

2.12.1 Answer Call  

Use the following methods to answer a call manually or automatically. 

NOTE:  When in Remote Office the Answer button is disabled. 

To answer a call manually: 
1) Select the incoming call from the switchboard. 

2) Click Answer. 

 

Figure 73  Answer Button 

To answer a call automatically: 

NOTE:  This feature only works if your device is Advanced Call Control (ACC)-compliant. 

1) To perform this function, you must select Auto Answer from the menu in the status 
bar.  When checked, the Answer button is disabled.  Each call from here on is 
automatically answered. 

2) The call is automatically answered.  Your state changes from Altering to Active. 

2.12.2 Blind Transfer Call  

Use this method to transfer a call to another specified number without providing an 
introduction to the destination party.  Calls may be transferred this way while active, held, 
or ringing (in) on your phone.  In the latter case, the system redirects the call before it is 
answered. 

1) While on a call, specify the destination number.  To do this, dial a number on your 
phone or select a number using any of the methods described in section 2.8.6 Service 
Level Report.  This automatically puts the customer on hold. 

2) Immediately click the Transfer button before the call is answered.  Select the 
destination number from the drop-down list. 
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Figure 74  Transfer Button 

2.12.3 Transfer Call with Consultation  

Use this method to transfer a call to another specified number with an introduction to the 
destination party.  Calls may be transferred this way while active, held, or ringing (in) on 
your phone. 

1) While on a call, specify the destination number.  To do this, dial a number on your 
phone or select a number using any of the methods described in section 2.8.6 Service 
Level Report. 

2) This automatically puts the customer on hold.  Wait until the called party accepts your 
call.  Speak to the called party. 

3) Click the Transfer button and select the destination number from the drop-down list. 

2.12.4 Hold Call  

Use the following method to hold an active call. 

1) Select the active call to hold from the switchboard. 

2) Click the Hold button. 

NOTE 1:  The Answer button changes to the Hold button depending on the context. 

NOTE 2:  When in Remote Office the Answer Hold/Unhold button is disabled. 

 

Figure 75  Hold Button 

2.12.5 Unhold Call  

Use the following method to unhold an active call. 

1) Select the held call from the switchboard. 

2) Click the Unhold button. 
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Figure 76  Unhold Button 

NOTE 1:  The Hold button changes to Unhold when selecting an already held call. 

NOTE 2:  When in Remote Office the Answer/Hold/Unhold button is disabled. 

2.12.6 Open URL  

When you receive a call, a notification window on top of the system tray is visible.  You 
can click a button in this notification to open a screen in your browser window.  This 
screen contains information about the calling party encoded in its URL.  This feature can 
be configured in the Options – Web Pop URL dialog. 

To open a URL in your browser, click the Web Pop URL button in the pop-up notification. 

 

Figure 77  Pop-up Notification 

NOTE:  You can also answer the call or save a vCard for the caller directly from the pop-up 
notification. 

2.12.7 Save vCard  

When you receive a call, a notification window on top of the system tray is visible.  You 
can click a button in this notification to save the caller’s phone number and personal 
information as a vCard in Microsoft Outlook. 

To save a vCard, click the Add vCard button in the pop-up notification window.  This 
button is present only when Outlook is running. 

2.13 Escalate Calls  
You manage calls using a combination of the panels in a top-to-bottom workflow style.  
You should be able to distribute calls typically using this workflow for most of the activities 
in the following sub-sections. 
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2.13.1 Blind Escalate Call  

NOTE:  When in Remote Office the Escalate button is disabled. 

Use this method to escalate a call to a supervisor. 

1) While on a call, click the Escalate button. 

2) Select the required supervisor’s name from the drop-down list.  Your call is 
automatically put on hold. 

 

Figure 78  Escalate Button 

3) To connect the parties before the call is answered, click the Transfer button 
immediately. 

 

Figure 79  Transfer Button 

2.13.2 Escalate Call with Conference  

Use this method to escalate a call to a supervisor through a conference call. 

NOTE:  When in Remote Office the Hold and Escalate buttons are disabled. 

1) While on the phone, dial the supervisor by clicking Escalate. 

2) Select the supervisor’s name from the drop-down list.  Your call is automatically put on 
hold. 

 

Figure 80  Escalate Button 

3) Wait until the supervisor accepts your call and speak to the supervisor about the 
issue. 

4) Connect the parties by clicking the Conference button. 
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Figure 81  Conference Button 

5) To drop a specific party from the conference, select their name in the drop-down list 
and click End. 

6) To leave the conference, select Leave from the Conference drop-down list. 

2.13.3 Escalate Call with Hand Over  

Use this method to escalate a call to a supervisor through a conference call and then 
leave the call. 

NOTE:  When in Remote Office the Hold and Escalate buttons are disabled. 

1) While on the call, dial the supervisor by clicking Escalate. 

2) Select the supervisor’s name from the drop-down list.  Your call is put on hold. 

 

Figure 82  Escalate Button 

3) Wait until the supervisor accepts your call and speak to the supervisor about the 
issue. 

4) Connect the parties by clicking the Conference button. 

 

Figure 83  Conference Button 

5) To drop a specific party from the conference, select their name in the drop-down list 
and click End. 

6) Leave the call by selecting Leave from the Conference drop-down list. 
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2.13.4 Escalate Call with Hold  

Use this method to hold a call and then escalate it to a supervisor. 

NOTE:  When in Remote Office the Hold and Escalate buttons are disabled. 

1) While on a call, dial the supervisor by clicking Escalate. 

2) Select the supervisor’s name from the drop-down list.  Your call is automatically put on 
hold. 

 

Figure 84  Escalate Button 

3) Wait until the supervisor accepts your call and speak to the supervisor about the 
issue. 

4) Connect the parties by clicking the Conference button. 

 

Figure 85  Conference Button 

5) Select the call to hold from the Call Line/Info drop-down list and click Hold. 

 

Figure 86  Hold Button 

6) To drop a specific party from the conference, select their name in the drop-down list 
and click End. 

7) Leave the call by selecting Leave from the Conference drop-down list. 
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2.13.5 Escalate Call with Mid-conference Hold  

Use this method to escalate a call to a supervisor through a conference call and provide 
an opportunity for the customer to speak to the supervisor on hold. 

NOTE:  When in Remote Office the Escalate button is disabled. 

1) While on the phone, dial the supervisor by clicking Escalate. 

2) Select the supervisor’s name from the drop-down list.  Your call is automatically put on 
hold. 

 

Figure 87  Escalate Button 

3) Wait until the supervisor accepts your call and speak to the supervisor about the 
issue. 

4) Connect the parties by clicking the Conference button. 

 

Figure 88  Conference Button 

5) Click Conference Hold.  The customer and supervisor can continue their 
conversation. 

6) To drop a specific party from the conference, select their name in the drop-down list 
and click End. 

7) Leave the call by selecting Leave from the Conference drop-down list. 
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2.13.6 Escalate Call with Consultation  

Use this method to escalate a call to a supervisor and provide an introduction beforehand.  
Calls may be escalated this way while active, held, or ringing out on your phone. 

NOTE:  When in Remote Office the Escalate button is disabled. 

1) While on a call, dial the supervisor by clicking Escalate. 

2) From the drop-down list, select the supervisor’s name.  Your call is automatically put 
on hold. 

 

Figure 89  Escalate Button 

3) Wait until the supervisor accepts your call and speak to the supervisor about the 
issue. 

4) Connect the parties by clicking the Transfer button. 

 

Figure 90  Transfer Button 

5) Leave the call by selecting Leave from the Conference drop-down list.  To drop a 
specific party from the conference, select their name in the drop-down list and click 
End. 
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2.14 Transfer Call 
There are a number of ways in which you can transfer a call to another contact. 

2.14.1 Blind Transfer Call  

A blind transfer occurs when a call is transferred without an introduction.  Calls may be 
blind transferred while active, held, or ringing (in) on your phone.  If a call is ringing (in), the 
blind transfer activity allows the call to be redirected before it is answered. 

To transfer a call to another agent without consultation: 

1) Dial the agent you wish to transfer the call to.  This automatically puts your active call 
on hold. 

2) Click the Transfer button and select Phone Transfer to <party> option. 

 

Figure 91  Transfer Button 

2.14.2 Consulted Transfer Call  

A consulted transfer allows the operator to announce or introduce the call to the called 
party.  A call may be consult-transferred while active, held, or ringing (out). 

To transfer a call with consultation to another agent: 

1) Dial the agent you wish to consult.  This automatically puts your active call on hold. 

2) Consult with the other agent once the agent picks up. 

3) Click the Transfer button and select Phone Transfer to <party> option. 

 

Figure 92  Transfer Button 
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2.14.3 Transfer Call to Queue  

To transfer a call to a queue: 

1) Select the call to transfer from the switchboard. 

2) Click the Transfer button on the Call Control panel. 

 

Figure 93  Transfer Button 

3) Click the target queue from the Transfer button drop-down list. 

4) Hold down the Shift key while clicking the queue from the drop-down list to transfer 
the customer to the front of the queue. 
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2.15 Supervisor Barge-In 
Supervisor Barge-In allows the supervisor to barge in on an agent’s call.  This is useful for 
when you want to enter an already established call between two other people.  This 
functionality is only available if you have been assigned this service by your group/system 
administrator. 

NOTE:  Supervisor Barge-In is only supported if the agent and supervisor are in the same group.  
In an enterprise, this function can be disabled. 

To barge in on an agent’s call: 

1) Select the agent on call from the Team panel in the Monitoring tab.  This is made 
visible by selecting View and checking the Monitoring box.  The agent must have a 
red phone icon to indicate that they are on a call. 

2) The Conference button should change to the Barge-In button.  Click the Barge-In 
button.  The supervisor is now in a three-way conference with the agent and the 
customer. 

 

Figure 94  Barge-In Button 

3) Click the Conference button to leave the conference.  The call is still active between 
the agent and the customer.  Alternatively, to drop a specific party from the 
conference, select their name in the drop-down list and click End. 

 

Figure 95  Conference Button 
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2.16 Supervisor Call Pick-Up  
Supervisor Call Pick-Up allows the supervisor to pick up an unanswered agent’s call.  This 
is useful for when you want to answer a ringing call that is in the queue.  This functionality 
is only available if you have been assigned this service by your group/system 
administrator. 

NOTE:  Supervisor Call Pick-Up is only supported if the agent and supervisor are in the same 
group.  In an enterprise, this function can be disabled. 

To perform a Supervisor Call Pick-Up: 

1) Select the unanswered call from the Team panel in the Monitoring tab.  This is made 
visible by selecting View and checking the Monitoring box.  The agent must have a 
green phone icon to indicate that they are on a call. 

2) The Conference button should change to the Call Pick-Up button.  Click the Call Pick-
Up button.  The supervisor is now answering the agent. 

 

Figure 96  Call Pick-Up Button 

3) To drop a specific party from the conference, select their name from the drop-down 
list and click the End button.  Alternatively, click the Conference button to end the 
call. 

 

Figure 97  Conference Button 
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2.17 End Call  
This section contains detailed instructions on how to end a call.  For more information on 
answering a call, receiving a call, doing a blind or consulted transfer, holding a call, saving 
a vCard, or opening a URL, refer to the corresponding sections. 

To end a call, select the active call from the switchboard and click End. 

 

Figure 98  End Button 

When in a conference, the End button allows you to drop specific parties from the call.  
Select the party from the Conference drop-down list and click End.  The party is no longer 
in the conference. 
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3 Glossary 

Name Description 

Active Call This is the call you are currently talking to or dealing with. 

Ringing (In) This is the equivalent to a phone ringing locally. 

Calling Party This is the party who you are receiving a call from. 

Called Party This is the party that you have dialed. 

Music on Hold This is music that is streaming from the service provider for a 
held call. 

Ringing (Out) This is equivalent to a phone ringing on the called party’s 
phone. 
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4 Keyboard Shortcuts 

The following is a listing of keystrokes (shortcut keyboard entries) that are available in Call 
Center. 

4.1 General Control Keys  
Keystrokes Equivalent Mouse Action Function 

ESCAPE Click OK/CANCEL/EXIT. Exits from the active window. 

CTRL+A Click on Available. States that you are available to 
take calls when you log in. 

CTRL+A Click on Unavailable. States that you are unavailable 
to take calls when you log in. 

CTRL+W Click on Wrap-Up. States your status as Wrap up 
on completion of a call 

<NumPad 0…9)  Allows to you to dial an ad hoc 
number. 

 

4.2 Menu Bar Control Keys  
Keystrokes Equivalent Mouse Action Function 

Alt + O Select Tools and then Options. Displays Options dialog box. 

Alt + R Select Tools and then Call 
History. 

Displays Call History dialog 
box. 

Alt + H Select Help and then User 
Guide. 

Opens BroadWorks Call 
Center User Guide. 

Alt + L Select File and then Sign In. Logs the user into Call Center.  
If the user is already logged in, 
performing the keystroke 
shortcut logs you out. 

ALT+L Select File and then Sign Out. Logs out current user from Call 
Center and returns to login 
screen. 

ALT+F4 Select File and then Exit. Exits the user from Call Center. 

F11 Click on Full Screen or 
Compact. 

Toggles between full screen 
mode and compact mode for 
the application window. 

 

4.3 Directories Control Keys  
Keystrokes Equivalent Mouse Action Function 

ALT+1 Click on Contact Directory tab. The Enterprise/Group Directory 
tab is brought to the front. 

ALT+2 Click on Personal Directory tab. The Personal Directory tab is 
brought to the front. 

ALT+3 Click on Speed Dials Directory 
tab. 

The Speed Dials Directory tab 
is brought to the front. 
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Keystrokes Equivalent Mouse Action Function 

ALT+4 Click on LDAP Directory tab. The LDAP Directory tab is 
brought to the front. 

ALT+5 Click on Outlook Directory tab. The Outlook Directory tab is 
brought to the front. 

ALT-M Click on Monitoring tab. The Monitoring tab is brought 
to the front. 

ALT-D Click on Dashboard tab. The Dashboard tab is brought 
to the front. 

 

4.4 Control Keys  
Keystrokes Equivalent Mouse Action Function 

ENTER Click on Dial. Dials the selected number. 

<NumPad+> Click on Transfer. Transfers the selected call. 

<NumPad.> Click on End. Ends the selected call. 

F1…F10 Click on Answer after selecting 
a call in the queue, or double-
click an active call. 

Designates a call to you.  F1 
applies to the first call listed; F2 
applies to the second call, and 
so on. 

F1…F10 Click on Hold after selecting a 
call in the queue, or double-click 
an active call in the queue panel. 

Sets a call to “On Hold”.  F1 
applies to the first call listed in 
the queue; F2 applies to the 
second call, and so on. 

F1…F10 Click on Unhold after selecting a 
call in the queue, or double-click 
an active call in the queue panel. 

Sets a call to “On Hold”.  F1 
applies to the first call listed in 
the queue; F2 applies to the 
second call, and so on. 

Ctrl + <Number Pad +> Click on Conference. Initiates a conference with 
linked call lines.  Performs 
Barge-In on selected contact. 

Ctrl + Alt + <Number Pad +> Click on Conference 
Hold/Conference Unhold. 

Toggles a conference from 
Held to Active state. 

Ctrl + Alt + Shift + <Number 
Pad +>  

Click on Leave Conference. Leaves a conference.  
Releases yourself from the 
active conference. 

Ctrl + Shift + <Number Pad +>  Click on End Conference. Ends a conference.  Releases 
all parties from the conference. 
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Index 

About tab, 42 
ACD states, 50 
ACD states, change, 43 
Ad Hoc number, dialing, 71 
Additional resources, 10 
Agent activity report, 56 
Agent status, display, 44 
Agent tab, 34 
Agent utilization report, 60 
Agents, first login, 11 
Answering calls, 80 
Available, change status to, 43 
Blind escalate call, 83 
Blind transfer call, 80, 89 
Call Center 

Agent tab, 34 
Panel, 25 
Supervisor tab, 36 

Call Center Activity, 44 
Call History 

Display, 45 
Call history directory, dialing from, 73 
Calls 

Answering, 80 
Blind escalating, 83 
Blind transfer, 80 
Escalating, 83 
Hold, 81 
Receiving, 80 
Transfer with consultation, 81 
Unhold, 82 

Calls, managing, 71 
Change status 

to available, 43 
to unavailable, 43 
to wrap-up, 43 

Chart information, dashboard, 51 
Conference calls, managing, 77 
Conference, escalating calls with, 83 
Connection tab, 33 
Consultation, escalating calls, 88 
Consultation, transferring calls with, 81 
Consulted transfer call, 89 
Contact directory, dialing from, 74 
Contact directory, display, 46 
Content panel, 26 
CSV, export reports, 54 
Dashboard tab, 51 
Dashboard, chart information, 51 
Dashboard, displaying, 51 
Dashboard, queue summary, 52 
Dialing 

Ad hoc number, 71 
From call history directory, 73 
From contact directory, 74 
From LDAP directory, 74 
From Outlook directory, 75 
From personal directory, 75 
From search, 72 
From speed directory, 76 

Directories, display, 45 
Directory, searching, 48 
End call, 93 
Escalating calls, 83 

With conference, 83 
With consultation, 88 
With hand over, 84 
With hold, 86 
With mid-conference hold, 87 

First login, agents, 11 
First login, supervisors, 16 
Hand over, escalating calls with, 84 
Hold calls, 81 
Hold, escalating calls with, 86 
Interface, main, 24 
Keyboard shortcuts 

Control keys, 96 
Directories control keys, 95 
General control keys, 95 
Menu bar control keys, 95 

LDAP directory, dialing from, 74 
LDAP directory, display, 47 
LDAP Integration tab, 37 
Login, first time for agents, 11 
Login, first time for supervisors, 16 
Login, subsequent use, 23 
Main interface, call center panel, 25 
Main interface, content panel, 26 
Main interface, menu panel, 25 
Managing calls, 71 
Managing, conference calls, 77 
Managing, queues, 77 
Matrix, time allocation, 55 
Menu panel, 25 
Mid-conference hold, escalating calls, 87 
Monitor queues, 44 
Monitoring tab, 49 
Number, re-dialing, 71 
Open URL, 82 
Outlook directory, dialing from, 75 
Outlook directory, display, 47 
Outlook Integration tab, 39 
Overview, 10 
Personal directory, dialing from, 75 
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Personal directory, display, 47 
Queue 

Performance analysis report, 64 
Position call in, 78 
Retrieving calls from, 78 
Summary table, 52 
Tranfer calls to, 90 
Tranferring calls between, 79 
Transferring call out of, to new number, 79 

Queues, managing, 77 
Queues, monitor, 44 
Receiving calls, 80 
Re-dialing number, 71 
Reports, 54 

Agent activity, 56 
Agent Activity, 56 
Agent utilization, 60 
Export to CSV, 54 
Queue performance analysis, 64 
Service Level, 68 
Time allocation matrix, 55 

Save vCard, 82 
Seach directory, 48 
Search, dialing from, 72 
Service level report, 68 
Speed Dials directory, display, 47 
Speed directory, dialing from, 76 
Summary, queue table, 52 
Supervisor barge-in, 91 

Supervisor call pick-up, 92 
Supervisor tab, 36 
Supervisors, first login, 16 
Time allocation matrix, 55 
Tools, 31 

About tab, 42 
Call Center Agent tab, 34 
Call Center Supervisor tab, 36 
Connection tab, 33 
General tab, 31 
LDAP Integration tab, 37 
Outlook Integration tab, 39 
Updates tab, 41 
Web Screen pop tab, 39 

Transferring calls 
Between queues, 79 
Blind transfer, 89 
Consulted transfer, 89 
Out of queue to new number, 79 
To queue, 77, 90 
With consultation, 81 

Unavailable, change status to, 43 
Unhold call, 82 
Updates tab, 41 
URL, opening, 82 
vCard, saving, 82 
Web screen pop tab, 39 
Wrap-up, change status to, 43 
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